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184

ADDING TRANSITIONS

Lesson overview
In this lesson, you’ll learn how to do the following:

• Understand edit points and handles.

• Understand transitions.

• Add video transitions.

• Modify transitions.

• Fine-tune transitions.

• Apply transitions to multiple clips.

• Work with audio transitions.

This lesson will take about 75 minutes to complete. To get the lesson files 
used in this chapter, download them from the web page for this book at 
peachpit.com/PremiereProCIB2024. For more information, see “Accessing 
the lesson files and Web Edition” in the “Getting Started” section at the 
beginning of this book. Store the files on your computer in a convenient 
location.

7
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Transitions can help create a seamless fl ow between 
two video or audio clips or inform the viewer that 
a change of scene has begun. Video transitions are 
often used to signify a change in time or location. 
Audio transitions provide a useful way to avoid abrupt 
edits that jar the listener or to blend the signifi cance 
of two scenes.
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186  LESSON 7  Adding Transitions

Starting the lesson
Although the most common transition is a cut—where one clip abruptly ends and 
another begins—there are great opportunities for creativity using transition effects 
you can animate.

In this lesson, you’ll learn to use transitions between video and 
audio clips to help your edits flow more smoothly. You’ll also learn 
best practices for choosing the most appropriate transitions.

For this lesson, you’ll use a new project file.

1	 Start Adobe Premiere Pro, and open the project Lesson 07.prproj 
from the Lessons folder.

2	 Save the project as Lesson 07 Working.prproj in the same 
folder.

3	 Use the Workspaces menu to choose Effects. Reset the work-
space to the saved layout.

This changes the workspace to a preset optimized for working 
with transitions and effects.

The workspace uses stacked panels to maximize the number of 
panels that can be onscreen at a time.

You can enable stacked panels for any panel group by opening the 
panel menu  and choosing Panel Group Settings > Stacked Panel 
Group. The same option will toggle off stacked panels.

Keep stacked panels enabled for now.

You can click the name of any stacked panel to view it. In the Effects 
panel, you can click effect category disclosure triangles to display 
their contents. The stacked panel automatically changes height to 
accommodate the listed items.

What are transition effects?
Adobe Premiere Pro offers several special effects and preset anima-
tions to help you bridge neighboring clips in a sequence. These 
transitions—such as dissolves, wipes, dips to color, and so on—
provide a way to ease viewers from one scene to the next. As well 
as smoothing the join between two clips, transitions can be used to 
focus attention on a major jump in the story.

Choosing and configuring transitions is an art. Applying them is simple enough: 
Drag the transition you want from the Effects panel onto the edit between two clips 
in a sequence.
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The skill comes in their placement, length, and settings, such as direction, motion, 
and start/end positions.

You can adjust some transition settings in the Timeline panel, but it’s usually easier 
to make precise adjustments in the Effect Controls panel. To view the settings for a 
transition effect in the Effect Controls panel, select it in a sequence.

In addition to the unique options for each transition, the Effect Controls panel fea-
tures a helpful A/B timeline display (more on this later).

This display makes it easy to change the timing of transitions relative to an edit 
point, change the transition duration, and apply transitions to clips that don’t have 
enough head or tail frames—that is, additional content to provide an overlap at the 
beginning (head) or end (tail) of a clip.

Knowing when to use transitions
Transitions are a standard storytelling tool in video editing, and the rules for their 
use are similar to the rules of screenwriting. They’re effective when they help the 
viewer understand the story.

For example, you may switch from indoors to outdoors in a video, or you may jump 
forward in time. An animated transition, a fade to black, or a dissolve can help the 
viewer understand that the location has changed, that time has passed, or that a 
character’s perspective has changed.

A fade to black at the end of a scene is a clear indication that the scene has fin-
ished. The trick with transitions is to be intentional—and this often means using 
restraint—unless, of course, a total lack of restraint is the creative result you want!

As long as it looks like you intended to include a particular effect, your audience will 
tend to trust your decision (whether or not they agree with your creative choice). 
It takes practice and experience to develop sensitivity for the right time, and the 
wrong time, to use effects such as transitions. If in doubt, less is usually best.

There is an established visual language that modern audiences recognize and 
respond to. For example, if a character falls asleep and the picture goes soft-focus, 
with everything in the frame glowing and bright, your audience will immediately 
know that we are witnessing that character’s dream. Studying this kind of visual 
language can help you make creative choices.
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Following best practices with transitions
You may be tempted to use a transition effect on every cut. Don’t! Or at least, get 
them out of your system with your first project.

Most TV shows and feature films use cuts-only edits. You’ll rarely see any transi-
tion visual effects. Why is this? An effect should be used only if it gives an additional 
benefit; transition effects can sometimes be a distraction from the video, remind-
ing viewers they are watching a story and preventing them from connecting with it 
emotionally.

If a news editor uses a transition effect, it’s for a purpose. The most frequent use in 
newsroom editing is to transform what would have been a jarring or abrupt edit into 
a more comfortable experience.

A jump cut is a good example of a scenario where a transition effect can help. A 
jump cut is a cut between two similar shots. Rather than looking like a continua-
tion of the story, they look a little like a piece of the video is unintentionally missing. 
By adding a transition effect between the two shots, you can make a jump cut look 
intentional and less distracting.

Dramatic transition effects do have their place in storytelling. Consider the Star 
Wars movies with their highly stylized transition effects, such as obvious, slow 
wipes. Each of those transitions has a purpose. In this case, it’s to create a look remi-
niscent of old serialized movies and TV shows. The transition effects send a clear 
message: “Pay attention now. We’re transitioning across space and time.”

Understanding the importance of clip handles
To understand transition effects, you’ll need to understand edit points and handles. 
An edit point is the point in your sequence where one clip ends and the next begins. 
This is often called a cut and sometimes simply called an edit. These are easy to 
see because Premiere Pro displays vertical lines to show where one clip ends and 
another begins (much like two bricks next to each other).

When you first edit a clip into a sequence, you set an In point and an Out point 
to select the part you want. When you edit that selected part of the clip into a 
sequence, the unused sections at the beginning and end are still available but hid-
den in the Timeline panel. Those unused sections are referred to as clip handles or 
simply handles.

There’s a handle between a clip’s original beginning and the In point you set. There’s 
also a handle between a clip’s original end and the Out point you set. The time ruler 
in the Source Monitor shows you how much footage is available in your handles.
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Playhead position In/Out duration

Original 
start

Original 
end

Handle Out pointIn point Handle

Of course, you may not have used In or Out points, or you may have set just an 
In point or an Out point at the very beginning or end of the clip. In this case, you 
would have either no unused media or unused media at only one end of the clip.

In the Timeline panel, if you see a tiny triangle in the upper-right or upper-left 
corner of a clip, it means you’ve reached the end of the original clip and there are no 
additional frames available.

No handle No handle No handleHandle available

For transition effects to work, you need handles because the effect creates an over-
lap between the outgoing clip and the incoming clip.

For example, if you want to add a two-second Cross Dissolve transition centered 
between two video clips, you need at least a one-second handle available on 
both clips (one additional second each that would not normally be visible in the 
sequence). In the Timeline panel, the transition effect icon gives a visual indication 
of the duration of the effect and, therefore, the clip overlap.

Adding video transition effects
Premiere Pro gives you multiple video transition effects to choose from. Most 
options are available in the Video Transitions group in the Effects panel.

Video transitions are organized into eight subcategories. You’ll find some additional 
transitions in the Video Effects > Transition group in the Effects panel. However, 
these effects are meant to be applied to an entire clip and are used to reveal the 
visual contents of the clip over time between its start and end frames (not using clip 
handles overlapping another clip). This second category works well for superimpos-
ing text or graphics.
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Applying a single-sided transition
The easiest transition to understand is one that applies to just one end of a single 
clip. This could be a fade from black on the first clip in a sequence or a dissolve into 
an animated graphic. Let’s give it a try.

1	 If it’s not already open, open the sequence called Transitions.

This sequence has four video clips and background music. The clips have 
handles, so transition effects can be applied between them (no tiny triangles are 
visible at the ends of the clips, which would indicate the last frame is already 
visible).

2	 In the Effects panel, open the Video Transitions > Dissolve group. Find the Cross 
Dissolve effect.

3	 Drag the effect onto the start of the first video clip. A highlight shows you where 
the transition effect will be added. When the transition is in the right position, 
release it.

4	 Drag another Cross Dissolve effect onto the end of the last video clip.

The Cross Dissolve icon shows the timing of the effect. For example, the effect 
you just applied to the last clip in the sequence will start before the end of the 
clip and complete by the time it reaches the clip’s end.

Transitions of this kind don’t extend the clip (using a handle) because the transi-
tion doesn’t reach past the end of the clip.

Because you’re applying the Cross Dissolve transition effect at the end of the 
last clip, where there is no connected clip, the picture dissolves into the back-
ground of the Timeline, which is black. The result is that this looks like a Dip To 
Black effect.

l	Note:  To ensure 
that the tools function 
and the defaults are set 
exactly as described in 
this lesson, reset the 
Premiere Pro prefer-
ences by holding the 
Option (macOS) or 
Alt (Windows) while 
launching the applica-
tion and then clicking 
Continue in the Reset 
Options dialog box. 

l	Note:  You can use 
the Search field, at the 
top of the Effects panel, 
to locate an effect by 
name or keyword, or 
you can browse the 
folders of effects.
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In reality you are causing the clip to become gradually transparent in front of a 
black background. The difference is clearer when you work with multiple layers 
of clips, with different-colored background layers.

5	 Play the sequence to see the result.

You should see a fade from black at the start of the sequence and a fade to black 
at the end.

Applying a transition between two clips
Let’s apply transitions between a few clips. For the purposes of exploration, you’ll 
break the less-is-best rule and try several options in one sequence. As you go 
through these steps, play the sequence regularly to view the results.

1	 Continue working with the previous sequence, called Transitions.

2	 Move the Timeline playhead to the edit point between clip 1 and clip 2 on the 
Timeline and then press the equal sign (=) key two or three times to zoom in 
fairly close. If your keyboard does not have the = key, use the navigator at the 
bottom of the Timeline panel to zoom. You can also create a custom keyboard 
shortcut for this purpose (see Lesson 1, “Touring Adobe Premiere Pro”).

3	 Drag the Dip To White transition effect from the Dissolve group in the Effects 
panel onto the edit point between the first clip and the second clip. The effect 
will snap to one of three positions, and the pointer will change to indicate which 
position the transition will occupy.

	Tip:  On an English-
language keyboard, it’s 
easy to remember that 
pressing the = key (if 
your keyboard has one) 
zooms in because there 
is usually a + symbol on 
the same key.
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Be sure to line up the effect with the middle of the edit, not the end of the first 
clip or beginning of the second clip.

The Dip To White transition effect gradually builds to a completely white screen, 
which obscures the cut between the first clip and the next.

4	 In the Effects panel, click the disclosure triangle for the Slide group of video 
transitions to display its contents. Drag the Push transition onto the edit point 
between the second clip and the third clip in the sequence, centered on the cut.

5	 Play through the transition to see the result, and then position the playhead on 
the edit between clip 2 and clip 3 by pressing the Up Arrow key. The Up and 
Down Arrow keys are shortcuts to move the Timeline playhead to the previous 
or next edit on targeted tracks.

6	 Click the Push transition effect icon in the Timeline panel once to select it, and 
open the Effect Controls panel (remember, if you can’t see a panel, it will always 
be listed in the Window menu).

7	 Change the direction of the clip from West To East to East 
To West by clicking the small direction control triangle to 
the right of the A/B thumbnail at the top left of the Effect 
Controls panel.

Each small white triangle changes the direction for the Push 
transition effect. Hover the pointer over a triangle to see a tool tip describing 
the option.

In the Timeline panel, play through the transition to see the result.

8	 In the Effects panel, expand the Page Peel group in the Video Transitions cat-
egory. Drag the Page Turn transition effect onto the edit point between the third 
clip and the fourth clip, centered on the cut.

9	 Review the sequence by playing it from beginning to end.

Having watched this sequence, you can probably see why it’s a good idea to use 
transitions with restraint!

Let’s try replacing an existing transition effect.

	Tip:  If the Effect 
Controls panel is empty 
when you open it, 
click once on the Push 
transition effect again 
to re-select it.

Select direction
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10	Drag the Barn Doors transition from the Wipe group onto the existing Push 
transition effect icon, between the second clip and the third clip. The new transi-
tion effect replaces the old one, taking the duration and timing of the existing 
effect.

l	 Note:  When you drag a new video or audio transition effect from the Effects panel on top of 
an existing transition, it replaces the existing effect. It also preserves the alignment and duration 
of the transition it replaces. This is a quick way to experiment with alternative transition effects.

11	Select the Barn Doors transition effect icon on the timeline so its settings are dis-
played in the Effect Controls panel. Using the controls in that panel, set Border 
Width to 7 and Anti-aliasing Quality to Medium to create a thin black border at 
the edge between the two clips.

12	Play through the transition to view the result. The best way to do this is prob-
ably to click a little earlier in the sequence to watch the video leading up to the 
transition.

If the video does not play smoothly during transition effects, press the Return 
(macOS) or Enter (Windows) key to render, wait for the rendering to complete, 
and try again. See the sidebar “Red, yellow, and green render bars” later in this 
lesson for more information about rendering.

Video transitions have a default duration, which can be set in seconds or frames 
(it’s frames by default). If the default duration is set in frames, the effective play-
back duration of a transition effect will change depending on the sequence frame 
rate. The default transition duration can be changed in the Timeline section of 
the Preferences panel.

l	Note:  You may need 
to scroll down in the 
Effect Controls panel to 
access further controls.
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13	Choose Premiere Pro > Settings > Timeline (macOS) or Edit > Preferences > 
Timeline (Windows). Depending on your geographic region, you may see a 
default Video Transition Duration setting of 30 Frames or 25 Frames.

14	This is a 24-frames-per-second sequence, but this doesn’t matter if you change 
the Video Transition Default Duration option to 1 second. Do so now, and 
click OK.

Existing transition effects keep their existing settings when you change the pref-
erence, but any future transitions you add will have the new default duration.

The duration of an effect can dramatically change its impact, and later in this les-
son, you’ll learn about adjusting the timing of transitions.

Apply the default transition effect to multiple clips
So far, you’ve been applying transitions to video clips. You can also apply transitions 
to still images, graphics, color mattes, and even audio, as you’ll see shortly.

It’s common for editors to create a photomontage, which might look good with 
transitions between the multiple photos. Applying transitions between two or three 
photos is quick and easy, but if you have 100 images, it will take a long time!

Premiere Pro makes it straightforward to automate this process by allowing you to 
set a default transition effect.

1	 In the Project panel, find and open the sequence Slideshow.

This sequence consists of several images placed in a particular order. Notice that 
a Constant Power audio crossfade has already been applied to the beginning and 
end of the music clip to create a fade in and out.

2	 Play the sequence by making sure the Timeline panel is active and pressing the 
spacebar.

There’s a cut between each clip.

3	 Press the backslash (\) key to zoom out the Timeline panel so the whole 
sequence is visible. If your keyboard does not have a \ key, drag the right end of 
the Timeline panel navigator to adjust the zoom.

	Tip:  If you discover 
a useful keyboard 
shortcut that uses a key 
not included on your 
keyboard, you can use 
the Keyboard Shortcuts 
dialog box to assign a 
different key.
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4	 If necessary, increase the height of the V1 track to see thumbnails on the clips 
(you can drag the dividing line between V1 and V2 in the track header).

5	 Using the Selection tool, draw a marquee around all the video clips to select 
them. Begin dragging in an empty area, away from the clips, or you’ll move the 
first clip you click instead.

6	 Choose Sequence > Apply Default Transitions To Selection.

This applies the default transition between all the currently selected clips. 
Notice that the Constant Power audio crossfade at the beginning and end of the 
music clip is now shorter because the default audio transition duration has been 
applied.

The default video transition effect is a 30-frame or 25-frame Cross Dissolve 
(though you changed this earlier to 1 second), and the default audio transition 
effect is a 1-second Constant Power crossfade. The shortcut you used replaced 
the existing audio crossfades with new, shorter ones.

You can set the default transition by right-clicking any transition effect in the 
Effects panel and choosing Set Selected As Default Transition. The icon for the 
selected default transition effect has a blue outline.

7	 Play the sequence to see the difference the new Cross Dissolves make to the 
montage.

Copy a transition effect to multiple edits
You can copy an existing transition effect to multiple edits using the keyboard.

Let’s try it.

1	 Press Command+Z (macOS) or Ctrl+Z (Windows) to undo the last step, and 
press Esc to deselect the clips.

2	 Select any transition effect in the Effects panel, and drag it onto the cut between 
the first two video clips in the Slideshow sequence.

3	 Select the transition you just applied by clicking its effect icon once in the 
sequence.

	Tip:  You’ll find the 
option to apply audio-
only or video-only 
transition effects in the 
Sequence menu too.

l	Note:  If you’re work-
ing with clips that have 
linked video and audio 
and Linked Selection is 
enabled in the Timeline 
panel, you can select 
just the video or audio 
portions by Option-
dragging (macOS) or 
Alt-dragging (Windows) 
with the Selection 
tool. Then choose 
Sequence > Apply 
Default Transitions To 
Selection.
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4	 Press Command+C (macOS) or Ctrl+C (Windows) to copy the effect. Then hold 
Command (macOS) or Ctrl (Windows) while you use the Selection tool to drag a 
marquee around multiple other edits to select them, rather than clips.

5	 With the edits selected, press Command+V (macOS) or Ctrl+V (Windows) to 
paste the transition effect onto all the selected edits.

This is a great way to add transition effects with matching settings to multiple edits, 
especially if you have taken the time to customize the effect.

Red, yellow, and green render bars
When you add a transition to a sequence, a red or yellow horizontal line (or render 
bar) may appear above it in the Timeline panel. A yellow bar indicates that Premiere 
Pro expects to be able to play the effect smoothly. A red bar means that this section 
of the sequence may need to be rendered before you can play a preview without 
dropped frames.

You can choose to render at any time 
to make these sections preview more 
smoothly on a less powerful computer.

The easiest way to render is to press the 
Return/Enter key. If you add In and Out 
points to select a part of your sequence 
and then render, only the selected sec-
tion of the sequence will render. This is useful if you have many effects that need to 
render but you’re concerned with only one part for now.

Red or yellow bars will turn to green when those sections of a sequence are 
rendered. Premiere Pro creates a video file for each section where the bar has 
turned green. The new video files are stored in the Preview Files folder (as set in the 
project’s Scratch Disk settings). As long as the render bar is green, playback should 
be smooth.
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Using A/B mode to fine-tune a transition
When you review transition effect settings in the Effect Controls panel, you have 
access to an A/B editing mode that splits a single video track into two. What would 
normally be displayed as two consecutive and contiguous clips on a single timeline 
track are now displayed as individual clips on separate tracks, with a transition 
between them. Separating the elements of the transition in this way allows you to 
manipulate the head and tail frames (or handles) and to change other transition 
options.

Changing parameters in the Effect Controls panel
You can customize all transitions in Premiere Pro. A major benefit of the Effect 
Controls panel is that, in addition to it giving you access to the settings for transition 
effects, you can see the outgoing and incoming clip handles (unused media in the 
original clip). This makes it easier to adjust the timing of an effect.

Let’s modify a transition.

1	 In the Timeline panel, switch back to the Transitions sequence.

2	 Position the Timeline playhead over the Barn Doors transition you added 
between clips 2 and 3, and click the transition to select it.

3	 In the Effect Controls panel, select the box for Show Actual Sources to view 
frames from the actual clips.

This makes it easier to assess the changes you’ll make.

4	 In the Effect Controls panel, open the Alignment menu, and choose Start At Cut.

The transition in the Effect Controls panel timeline, and in the sequence, 
switches to show the new position.
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5	 Click the small Play The Transition button  at the upper-left corner of the 
Effect Controls panel to preview the transition beneath the button.

6	 Now change the transition duration. In the Effect Controls panel, click the blue 
numbers for the Duration, type 300, and click away from the numbers or press 
the Tab key to apply the new setting. Premiere Pro will add the correct punctua-
tion automatically, changing 300 into 00:00:03:00—that is, 3 seconds.

The Alignment menu changes to Custom Start because the effect now reaches 
beyond the beginning of the next transition effect. To make the new transition 
duration fit, Premiere Pro automatically sets its start two frames earlier.

Examine the A/B timeline display in the Effect Controls panel timeline, at the 
right side of the panel. There is a zoom navigator at the bottom of the Effect 
Controls panel timeline that works just like the one in the Monitors and Time-
line panel. Zoom out by dragging one of the circles on the navigator to make it 
longer, so you can see the ends of the clips.

In this example, the Effect Controls panel playhead is centered on the cut, and 
you can see the way the effect timing has been adjusted automatically.

7	 In the Timeline panel, play through the transition to see the change.

These automated adjustments can be subtle, so always double-check the results 
of new settings by playing through the effect. This way you can be sure you’re 
happy with the newly revealed media taken from the clip handles—the media 
that was hidden from view until you added the transition effect. Although it’s 
useful that Premiere Pro automatically modifies the timing of effects when 
necessary, it makes it even more important to check the transition before you 
move on.

Now let’s customize the transition.

8	 In the Effect Controls panel timeline, hover the pointer over the middle part of 
the vertical black line that crosses all three layers (the two video clips and the 
transition effect between them). The line is the edit point between the two clips. 
If your pointer is correctly positioned, it will change to the red Rolling Edit tool.

l	Note:  If the Effect 
Controls panel timeline 
is not visible, click 
Show/Hide Timeline 
View  at the upper-
right corner of the 
panel. You may need to 
resize the panel to make 
the button visible.

l	Note:  It’s possible to 
shorten a transition to a 
duration of one frame. 
This can make it hard to 
grab and position the 
transition effect icon, so 
try using the Duration 
and Alignment controls. 
If you want to remove 
a transition, select it 
in the sequence in the 
Timeline panel and 
press Delete (macOS) or 
Backspace (Windows).

	Tip:  You can posi-
tion the start time of a 
dissolve asymmetrically 
by dragging it to a new 
position. This means 
you don’t have to settle 
for the Centered, Start 
At Cut, and End At Cut 
options. You can drag 
the position of a transi-
tion effect directly on 
the Timeline too.

Sam
ple

 p
ag

es



ADOBE PREMIERE PRO CLASSROOM IN A BOOK 2024 RELEASE  199

This edit line is close to the left edge of the effect, so you might want to zoom in 
to the Effect Controls panel timeline to conveniently make adjustments.

In the Effect Controls panel, the Rolling Edit tool lets you reposition the timing 
of an edit between two clips by dragging the edit line.

9	 Still in the Effect Controls panel, drag left and right with the Rolling Edit tool. As 
you do, you’re changing the timing of the cut. The Out point of the clip on the 
left of the edit and the In point of the clip on the right of the edit update in the 
Timeline panel when you release the drag. This is a form of trimming.

You’ll explore trimming in more detail in Lesson 8, “Editing Video—Advanced 
Techniques.”

10	Move the pointer over the transition to the left or right of the edit line in the 
Effect Controls panel, and the pointer changes to the Slide tool. If there is a blue 
line, it’s the time ruler playhead.

Using the Slide tool changes the start and end points of the transition with-
out changing its overall duration. Unlike using the Rolling Edit tool, moving 
the transition rectangle by using the Slide tool does not change the edit point 
between the two sequence clips. Instead, it changes the timing of the transition 
effect.

11	Use the Slide tool to drag the transition rectangle left and right and compare 
the results.

Using a Morph Cut effect
Morph Cut is a special transition effect that aims to be invisible. It’s designed to help 
with “talking head” video interviews, where a single speaker looks in the direction of 
the camera. If your subject pauses a lot or there is inappropriate content in the foot-
age, you may want to remove a section of the interview.

This would normally produce a jump cut (when the image seems to jump suddenly 
from one piece of content to another), but with media that changes very little over 
time, and a little experimentation, the Morph Cut effect might yield an invisible 
transition that seamlessly hides what you have removed. Let’s try it.

1	 Open the sequence Morph Cut. Play the beginning of the sequence.

This sequence has one clip, with a jump cut near the start. It’s a small jump cut 
but enough to jar the audience.

	Tip:  You may need 
to move the playhead 
out of the way—earlier 
or later—to see the edit 
point between two clips 
in the Effect Controls 
panel timeline.
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2	 In the Effects panel, look in the Video Transitions > Dissolve group for the 
Morph Cut effect. Drag this effect to the join between the two clips.

The Morph Cut transition effect begins by analyzing the two clips. If the play-
head is over the transition effect, you’ll see a banner across the screen while the 
analysis takes place, but you can continue to work on your sequence without 
waiting.

Depending on your media, you may achieve improved results with the Morph 
Cut transition effect by experimenting with different durations.

3	 Double-click the Morph Cut transition effect to display the Set Transition Dura-
tion dialog box. Change the duration to 16 frames (you can double-click any 
transition effect to access this setting).

4	 When the analysis is complete, press Return/Enter to render the effect (if your 
system requires it) and play a preview.

The result is not perfect, but it’s close, and it’s unlikely an audience will notice 
the join.

Dealing with inadequate (or nonexistent) 
head or tail handles
If you try to extend a transition for a clip that doesn’t have enough frames in the 
handle for the new duration of the effect, the transition still appears but has diago-
nal warning bars through it. This means Premiere Pro is using a freeze frame to 
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extend the duration of the clip. The last available frame is held onscreen to complete 
the transition effect.

You can adjust the duration and position of the transition to resolve the issue.

1	 Open the sequence called Handles.

2	 Locate the edit between the two clips.

These two sequence clips have no heads or tails. You can tell this immediately 
because of the little triangles in the corners of the clips; a triangle indicates the 
first or last frame of the original clip.

3	 Select the Ripple Edit tool  in the Tools panel, and use it to drag the right 
edge of the first clip to the left (begin dragging just to the left of the cut between 
the two clips). Drag to shorten the duration of the first clip to about 1:10, and 
then release. A tool tip appears while you trim to show the new clip duration.

The clip to the right of the edit point ripples (moves) left to close the gap. Notice 
that the little triangles at the end (the right edge) of the clip you just trimmed are 
no longer present.

4	 Drag the Cross Dissolve transition effect from the Effects panel onto the edit 
point between the two clips.

You’ll discover that you can drag the transition onto the right side of the edit 
but not the left. That’s because there’s no handle available at the beginning of 
the second clip to create a dissolve that overlaps the end of the first clip without 
using freeze frames.

5	 Press the V key to select the Selection tool, or click to select the tool  in the 
Tools panel. In the Timeline panel, click the Cross Dissolve transition once to 
select it. You may need to zoom in to make it easier to select the transition.
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6	 In the Effect Controls panel, set the duration of the effect to 1:12.

The clip handle is not long enough 
to create this effect; the diagonal 
lines on the transition, both in the 
Effect Controls panel and in the 
Timeline panel, indicate Premiere Pro automatically added a freeze frame to fill 
the duration you set.

7	 Play the transition to see the result.

8	 In the Effect Controls panel, change 
the alignment of the transition to 
Center At Cut.

9	 Drag the Timeline panel playhead 
slowly through the transition and watch the result.

•	 For the first half of the transition (up to the edit point), the B clip is a freeze 
frame, while the A clip continues to play.

•	 At the edit point, the A clip and the B clip start to play.

•	 After the edit, a short freeze frame is used.

There are several ways to fix this kind of issue.

•	 You can change the duration or timing of the transition effect.

•	 You can drag the edit in the Timeline panel using the Rolling Edit tool  
(click and hold the Ripple Edit tool in the Tools panel to access it) to change 
the timing of the transition in the Timeline panel. Be sure to drag the edit 
between the clips and not the transition effect. This won’t necessarily remove 
all the freeze frames, but it may improve the overall result.

•	 You can drag one side of the edit in the Timeline panel using the Ripple Edit 
tool  to shorten a clip, increasing the length of the handle. Again, be sure 
to click the edit between the clips and not the effect icon.

You’ll learn more about the Rolling Edit and Ripple Edit tools in Lesson 8. For now, 
make sure you have the Selection tool selected.

l	Note:  The Rolling 
Edit tool lets you move 
the transition earlier 
or later but does not 
change the overall 
length of the sequence 
because it extends one 
clip while shortening 
another.
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